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Create a new Presentation 

1- Click the Microsoft Office Button , and then click New.  

2- Under Templates, you see options you can use to create.  

3- Click the Blank and recent. 

4- Click the Create Button. 

Save your Office PowerPoint 2007 Presentation 

1- Click the Microsoft Office Button  and then click Save. 

2- The Save As dialog box appears. 

3- In the File name box, enter a name for your presentation, or do 

nothing to accept the suggested file name.  

4- In the Save in list, select the location that you want to save your 

presentation to, or do nothing to accept the suggested location.  

�������������������� To save in a new folder, click Create New Folder  . 

5- Click Save.  
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Accept )	���M 

Appear +"#���Z��

Button �%4���

Close )	����

Layout [�+��"��

Note �/#������

Open +�X������

Placeholder �"���"&L���

Presentation �%��'���������

Quick Access 
�s
	
��i��

Ribbon ��+0���

Save 9n���\��
��

Slide >
��"��

Sort @���\��
��

Suggest +������&,1�M��

Template 0L5���

View �%���

Window �c,M��

Zoom ��V��%,�s��
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• �%����'DPresentation�E�6�����������0F����)	��+����+�1������G������������ %��� ��H ;	��*�0<����

<��"�����s���	����-��0#$��

• ���V���U�PowerPoint 2007	&��������0&1����)��%��\����V���U��)����� 4�/ 
��'������s :

������U���	�������0!0��\����\��V��Offices���"#��$��

• ��:1��s-<��dV!�B���%���",���'��>
��������� ���4�/
��"���s��� �������-4��� c� �������F ���+0 	������

�����0%��"<����P0������*�.0��L/
�$��

• ���V�����0�Quick Access���0I,����
�s
	
��+�������i�V������0������,�+?�\���s������+�0�

K�������$��

• ������;��+�4����
������������������4�Y������������� �����@ 5�f����s CA,��s #���� ��)�����G -	(��\� �

������"#�\",�����������YC�������������09����k0���U������������4�"������ 4�/ 
���"��1��B��f�s

����0��"#�����$ 

• PowerPoint�����B�9n��09�o�9�@5�f����������s����",4�$���PowerPoint 2007����B����� ��� �

�"�0�Mpptx�$9n�s����"�0#$ 
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� �ID���.ppt������ �J��.pptx�� �K��.docx��� �����.xls��

�� ����	������.�BB����������.�L)B-�,����ME�A�������7PowerPoint��L
�=�������L���A�L����L��"���9���

�����"�"
�H�B��.�9�:
����7 

� �ID���]������/#����� �� �J�]����>
����"��

� �K�������Slides ����� �� �����������Outline��

��� ���������)�����N����7�!@�A����,�����	��������"�"
�	BOffice
�.��5?���=�H�"� 

� �ID���Open� �J��Save ��� �K��Save As�������� �����New��

�� A����,��7�����	���������=
�.��5?����9����,��N��H�"� 

� �ID���Normal�� �J��Notes Page��� �K�Slide Show �� ���Slide Sorter  

'� ���*+��.��,���8�����O�������N��P�$E�	��7�*+���$Q�!@�A����,��R����.���.������	B

�	���Office
�.��5?���=�H�"� 

� �ID���Open�� �J�Save �� �K��Save As�� �����New��

(�� ���� ?M������N�S6�� .�)B-�#���	?M�#;��7=�	
����PowerPoint!@�A������	B


�.��5?��=�H�"� 

� �ID���V����,Close ��%4�����Office�������������

� �J�-4�����N�� J���/
���/%
������c,M���

� �K��-4����N�� J���/
���/%
������c,M���

� �����-4����N�� J���/
���/%
������c,M���

7- To save a new  presentation you: (Select all that apply) 

a- Select Open button on the office button 

b- Select Save button on the office button 

c- Select New button on the office button 

d- Press <Ctrl> + <F5> 
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C	D�1��*����
�� �%��"!�'�"������#0M�������+?�����4���cMy Document�U������First Exercise 9n��,4���"$ 

�� +��"�[����\"�"!�"�>
���Two Content"�,4����P��'��%�����$ 

��� ��%��'First Exercise ��+�"��������������c,M��:,PowerPoint ",�����0#��	����"$ 

�� �%��'First Exercise %������4�������`���)�����?��0!����"�!��U� ���������4��Second Exercise�

��������0aD"!��#0M�������"���U�������4�Exercises�������c��,4�9n��"��%�����"$ 

'� V���,New 
	
����V�����0���������
���i(Quick Access),4����P���"$ 

(�� �U������\�������������0!0��Home0,��������"$ 

/� 
���,4���%4��"Save ���Save As�%4������Office�*�� ����[���� ������	����" ������ ��� ��������� c

0,����"$ 
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 � ��������� �!"����#$�%���&�'(��)���
�*�	��+ ����������������&� 

!� ,-���������.��������&���	��/��)�����/�0�� 

"� 1��� �23"�45�%�����������������������&���	���)�	� 

#� �����/���
�!���������	���
��������� ���.����� 

$� 
�6���7�8� Slide Master �����������
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���������������	
����������������������������������������������������� �����!"�#�����$���%���&�'()�*��+�,-.��
�����-/�0����1���2����-���3����������������-��4���5�(1�����6�&�����������������'( ����&��- ��7��� �&��8.�89�

2:��;��()��:����<��0�����3�����(�=>)�����1;��8?�������&��6��"�@	-#����)�8?�����5��*-������13���
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���������������-��4������������������A�����&����������- ��5�.���B8.�(Placeholder)�	C�� (�������- ��&�5�� C�D
���,-E�������.�����(������A;�F:�����>������� ��� � �� �G�����C�H�3��8�)���� I����5�.���B8.������J����-���C���� 1��������� C�

�������� >C�����K.��J�A;�5�&�L�AutoFitM����FN 1OPQ�R����� ��2>E I���(������������)� S�5� .���B8.���� C�H 9�&��
�����1�3��������5��*-�����������>C���������	N1�������5�.���B8.�A���������(���������! ���-���A;�F :����-���C���C�'

T��5�.���B8.�5���.����((��C��3��

��
�342����-5��AutoFit  

�����.����������>%����� ��������G��� �Outline��6�.����(���Slides/Outline�.�(���U�������A����������� ���� ���-��A��C����&�����5��*- ����
����3��1����-1����J��(���������C��������.���������V,/�� � �� � �����>.��-��H�������W��I��A���� � � ��� �� �� ����� ��� �� ���� �� ��3��������������.������� ������X()���� �� �������� .�0���� � � �

�>.��N(/��0�$�.�N��� � ��� � ���� � �� ���� � �����C�5��*-���A���� � � ��� �� �� ��� �� �3���

������A��K/� � � � ��(	C�� ��� � Enter ����/�%�����J������D�� � �� ��� ��� �� � �� �� � ��� �����1� � ��3���C����8�)� � �� � �� �� A�N�� �� ������ ��2��������5��>1��&���>.����� �� � ��� �� � ������ � �� � ���� �
A��K/� � � � ��(	C�� ��� ��Y(����� ��� � �� Ctrl+Enter ��� ��������F:���'(.���� �� � ��� � �� �� ���� � �-L��A;����&�5�1� �� � �� ��� ��� ��� ���'()���� �� � ���3����A����� >��:��������� � �� �� � ��� �� �� �

������&���������-L����� �� ���� �� �� � ��� �� �� � �� � �(	C������G�������8�������� ��� �� ����G�� � � � �� � �� �� �� � ��Y(���� Ctrl+Enter ������'()����K/� �� � ���� �.��

������� � � ����������������� � ��� ������4���&����� �� �� ������-���� � ��.�������5��*-���� ���������� �� �� �Outline��

�� ����.��PowerPoint�C���J������� ��� � �����(��������������>.�D�� �����?�:�7��� ����-:������� ���� �(�0����I��>1���� ���� ���� � ���(���� ��3�� 

�>C��AutoFit 

T�((!���-���-��5���.�����5���.����
5�.���B8.�� T��W��((��Z�����-��5���.������

5�.���B8.��
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	� ��>C����OfficeU0������Save�C�[�#-.�����(�� >.�&����� 1���������7My Presentation Files �
�����C�����6�&���������+&���D:�����)��-:���DE(�W�.������Example1:\�(�C�5�(�3 


�� 6�.���(��Slides/Outline&�����.����Outline	C�(�C�D(�M�3�FN1QPQR 

��
�342�����

�� �]/����	:����6�.�(��Outline	C�(�C�D(A�N��������>.��>.���1�5����7�M�FN1^PQR3 

��
�342 ��� 

�� �$��Y�"Outline Tab"��������C�H� (	C�&��� (��� Y(����Enter _ Ctrl��)����K /�A� �U>)���� (��� �
MFN1�`PQR3�����6����C(����-���C���6�.����5�1�H(��Slide.�(�>.�U���5����7����13��

��.���Outline 



��

!:� �

�!9���:������ ���;�<��) =/>�"� �!�>���)�	�����!�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���
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�342!����

������ � � ���������������(	C��������(?&��A������-��H��������_���(1����-1����J����Y(�����Ctrl+Enter������ ()����K/����
����������1�4���������(�������B8.�J����$��"���(,�����3������(	C��C�����
���Enter�����B����������������� ���� ()����K/��

�1��)��:�����������J3 

�� ��$��Y�����������C�H(�M�b�FN1cPQR 

This is a great place to start writing your content. 

�� 5��1��&�����d&����0�2>�������6�.�2���(�Slides/Outline )����I�(��FN 1���.�>)�����ePQ�
T�((������3 

�� ��T������_�((����5�� 1��FN 1�������A;��d&� ��� 0����������C�f���2 ����2> ��� ������ (����� �B��� �����6�.�� (��
Slides/Outline�U/����7�����3�]/�A��C���������>.��������-��7�6�.��(�������J&���3 

�� &���B-.����:;�����$��Y����	C��5�1�H(�C�D(	C�&��(��Enter)����K/����(�3 

��� ��$��Y�����������C�H(��3 

The Outline Tab shows your slide text in outline form. 
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��� �?�6������A�N���C�����B-.������>.���:;��������>	C�������	C��2 ���5�1�H� (���� Y(�����Ctrl+Enter�����
)����K/(��3 

�	�   ������J  ����  >.�������7�  ����  ���������A;�A��  ����  C�2  ���5��  �;�&���  1  ��C�H  (��� �
M�FN1gPQR3 

 
�342$����



��

!�� �

�!9���:������ ���;�<��) =/>�"� �!�>���)�	�����!�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

������ � � ����A�N���C��-?�6�������>.��&��(	C�A��K/��2�����������/���&��������NEnter ���/� %��!J����
���������1��)��:������A�>)������8������/��-N.�A�1�3�����������(	C������������J�����������������2?�6��������� Y(C���

Ctrl+Enter�(�C�5��*-���3 

���������������� (Design Template) ��

�8?��6��"���(Design Template)h�"������)�5���;���������-*0���1BJ���F��I�7#���C����U J�������
���>.�D���YI����7(����i.��F(��W� /���)��� B8.�J�j�.�&����_������� )���?��A� -��� (2E��� )��2 ��������� ���

5��>1�E��&����(��������������8(A����$�>���������(6��"�A;����7�����&�(2���5�1�'�3��

���PowerPoint 2007  -I&����  >C�����OfficeU0�����  �New  ��[�  #-.��������C  (5�&�  L�����  C���� �
New Presentation��5�)�K����U0��C���1�����)�*	-#���������>.�2:�����J�7�-:�������� (����� I���

����)���C�������C�6�&&��+���A;����k?�>J����"����1���1;��)�M�FN1lPQR3��

��
�342/���1���;����5�New Presentation 
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• Installed Templates���)�8?��W�>��&��5�1�!�.��m��C�(�>.�������5����7����13 

• Microsoft Office Online��������)�8?��2>EI������F��I���� �����2/�����2������2/� �&�N
�-���������)����>.�@	-#����2���5�1�5����7�3���
����������C��1���5�1�F
&�2.�-�(��� ����

	C(�&��D���)���-������D����������I���)�������8?��2/������ ������ �.���� ������2���2/� �&�N
)��:(������3 

�8?��[�#-.���������5�&�L�����C�2����2>�������.������New Presentation���(�� >.�7��� 8?��7��
�����)��:�5�)�K��F��I�5�1�[�#-.�3��

����
������&���C������>C��Create�	C�(��>.�D(���>.������J�7�������� 8?��d���������������5� 1�[� #-.�������� �
�1��)��:3��

�����	�����>.������J�7��)�8?��d�������������(7��5�1��-:����

�� ����>C�� OfficeU0���� �New��[� #-.�������C� (��5�&� L����� C���New Presentation ��5�)�K ��
�����13 

	� U0����Installed Templates�C�[�#-.�����(���� )�8?��W� >��� ������&��5� 1�!� .���m�� C�(�����
�>.���1�5����73 


�� &����  N��  )�8?������	C���  J���  (�C�D  (6�.�����  ���  (�5�&�  L�����  C�2  ����2>  ���� �
New Presentation��(7��>.��C�5�)�K������"�����7(�3 

�� &���Create	C�(�C�D(��3 

�>.��J�7����8?��d����������#-.���������������13��

����������� �
�����!(Themes)��

'���h�"���)��)��������(7��-:����������-E)�����>����C�����2.�/������i.����)���!?�I�&��)�������)���������n�����C�
��oJ(��)�S�2����������)����.�1����� .��������3�������� ����� J���� >��� ����� (�������� C�PowerPoint�� �������� "

�(7�����p�/��������������)�(�*����(���2.�/����&����)�������?�>_��2?�6�&�5���.��������� >.���� ��7���� )��3��� ���
�>.�A��C�[�oJ���7���[�#-.�����A����N�'���������������A;���)���C�+�>����3��



��

!!� �

�!9���:������ ���;�<��) =/>�"� �!�>���)�	�����!�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

�����[�#-.�����.��������'��DDesign��N�h�"������)��5&�0������J���Theme�C�[�#-.�� ���(��3�h�"
	C�������U�(������)���>.����+�>���7�����1M�FN1qPQR3��

��
�3426��<7�=�>��	�(Theme)  

"����#$��%%&���!��	
���'%��()��*+�,��
�����������!"�#��[oJ����kK��>.�Z�)�������(��r�������Z��(E���(s�3����PowerPoint�����5&� 0����k��)��U���

Background�����.�������Design�������((T��Z����������2���5�1��-/�0���.�����)�������(���3���������C�����Z���
��.��� Design���U���2����2>������C�k�(�������&��A�N(��Z&�Background Styles�k ��5�)�K�������� 1

h�"�Z�?�0�����(�C�D(	C����Z�)�������7��>.���(��M�FN1OtPQR3��

��
�342�:������	?@	Background Styles�1�
�����Background  

5��1��A�������I����&����0d�D���)�Z&��h�"�������)7(��kK��>.k��5����7��>.���������A;�������13��

����U0�Z&��D(	C���Format Background 5�&�L����C���k���)�S�Z�������5��*- ���� ��� C���� 0�� .������Z� )
k��A;������J���k0u�&��(	C�A������>.�'(�������7��>.���(������v�����Z�)M�3FN1�OOPQ�R��
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��
�342������1���;�����5�Format Background  

��.������Fillk��5�)�K��'(����������1b��

Solid fill������k-��s�i.�k��+�>���7��>.���(��������C3��

Gradient fill�k��+�>���7��>.���(���������$&�*-��i.��&�����kY(C������C3��

Picture or texture fill����A�����������Z������F��/�D��[�#-.���k��')��/�7��>.���(�����C3��

�����
�����i.���((T��7��>.���(����

�� �7��>.Example1.pptx�����+�w������CO����C���������(�C������3 

	� ������U ���2 ����2> ������(�������&��A�N(����Background Styles����Z�?� 0����&�� (�C�D (	C�
h�"��h�"����J���Z�)Style 5�(��U0������3 


�� ���U���Z&��5���&�Background Styles�D(	C��(������U0���������&�Format Background����
�(�C�[�#-.�3 

�� � 5�&�L�� ���C� ��Format Background� �.���� ���Fill� ���U0� �Solid�Z&�� &� 5��C�[�#-.�� ���
����U0�A�N(�Color��(��>.�[�#-.�������:�5��#?��i.��&��(�C�D(	C�M�FN1OQPQR3� 



��

!#� �

�!9���:������ ���;�<��) =/>�"� �!�>���)�	�����!�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

��
�342��������A�?�Solid fill 

�� �'(�������5��*-�����Transparency�(�C�'(�������k��#-.����(���2(/�*1��3 

�� ��>C��Z&�Apply to All�������(��>.�D(	C����0�+�>����)�����W�>��������#-.����(��3 

����������U0�����C������J����8���Z�)Format Background��(��>.�k�������3��

-����.�/0��12�3�+��4�5��(��5	
����!���

��������_���������������.������$���%���4���&��)�(�)�0�����������������x�!?�y��A����+�,-.���-B����� :���2���W��
������J��)������J��-6����:�����������<o6��8�.�1�3�������<o6�����J�����J������D��������9����������-����� ���
A;���C�[�#-.������)3��

����	�������������� ��

�>.�����������.�������Slides���>.������!���������(Slide Sorter) ������[�#-.������D�&������A;�
	C(�C�D(��&����������9�[�#-.������
���� �������C��2K���)��&�� ��-��� ���1���')���������

	C�+&�(�C�D(	C��m��&��(��Shift	C��L*
����(�������(�&��&��-1����8.�������	C��:;��(�>.�D(���3
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z� ��(�� ��	C�$��
��(��Ctrl	C��L*
����(��� ����(�&�� &��-1����8.��������)��	C���.������(�D
�C(�3��

	���	����!"#���� ��

��������������>.�D�)�0�7�:���2���W�x������������.�1�<o6��)���<o6���D������9�����
A;�[�#-.�����������)�(	��Delete	C��L*
����(()����K/��������&����A;��	C��)(U0�&�5��C�2����D����

Delete Slide�C�[�#-.�� ���(�����.��������Home�0�����5&SlidesU0������Delete Slide	C����(�C�D(��3
M�FN1O^PQ3R��

��
�342� ����BC����D�E)	��AF������
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!/� �

�!9���:������ ���;�<��) =/>�"� �!�>���)�	�����!�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���


���	�$%�&�'(&������ ���

����������Z�>.�����7��>.�D��Z�)�����A��C�kmCSlide Sorter�&�5��C�[�#-.�������.�����������
����.������Home������U���Z&��Copy����5&�0����Clipboard���D(	C����(�CM����(	C���Ctrl���������(�� ������ (	C��L*
����

������(	C�&��-1����8.C����()����K/�����R��������������5&� 0����&�5�� ����.������FL��������d&����m�Clipboard��Z&��
����U��Paste���(��>.�D(	C�M�3����(	C���Ctrl��������������� (	C�&��- 1���� 8.��(��������(	C��L*
����V������ ()����K /����R�

M�FN1OaPQ3R��

��
�342�!�����1�
�Clipboard�

�����	�)�*+�$%�&��*������ ���

��J����Z������()��#���=.��9���Z�>.������(�C��JSlide Sorter�����&�5�� C�[�#-.�������.�����������
���.���Home������U���Z&��Cut����5&�0����Clipboard�����(�C�D(	C�M���(	C���Ctrl����� 8.��(�� ������ (	C��L*
����

�����(	C�&��-1��X����()����K/�����R�����5&� 0����&�5������.������FL��������d&����mClipboard����U ���Z&��
Paste��(��>.�D(	C�M��(	C���Ctrl��(	C�&��-1����8.��(��������(	C��L*
����V�()����K/����R3���

6���7�������
�	
�����!���

�������C���.;��������?&��d��������)����A;�2:���2���>.��)�����5����7���)�0����1���������,-.������&�j�%����-B��+
���>.�!?�y��W��E.��������2���W�x��7�����J�����)�����C��J('�3�����!���������������5�����)���� �����{&���

�>.����5��*-���!�������� ��(Slide Sorter) � ��J�&����� J��� ������{&��D >C�� ���)����� )��&�A�(K ��
A���(Drag & Drop) �2���3�>.�����-Y?��������(Normal)��.�������Slide� ��')���.���� (���� �������� C��

�)��W��.�(��3�����
�����������������_���C���)����>.�����7�������������� C���.;������1������ ����� ����� >.����)���
�->C�������������2���5�)�K��F��I�A��U>)���"�!�����������������A� ���� ���)�� (�-K�.�� ()��:���� (��
21���M�FN1OcPQR3��
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��
�342�"����-��+G7
�����)+�(Slide Sorter)  

��������A��������>.�����4����7�!�����A;�������������<o6�&�����

�� �>.��7Example1�+�w������C����O���������6�&�������� ���D��� 1���My Presentation Files�
-:��(��������C(�3 

	� ��.�����Slides6�.����(��Slides/Outline&�����:;��������	C��(�C�D([�#-.��������1�3 


�� ��.������Home�5&�0����Slides&�����(�� �����&��A�N(���� >C���New Slide	C�� (�C�D� (��� ���
?(9�2E(A�����)��>.�5�)�K�����@	-#��(���3&��9�(�A���Title and Content 	C�(�C�D(��

�������J����������1�����3 

 



��

":� �

�!9���:������ ���;�<��) =/>�"� �!�>���)�	�����!�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

�� 5�.���B8.���Title A����� Slide Sorter View&�5�.���B8.���Content ���-������(�C�H�������3 

�Slide Sorter view is a view of your slides in thumbnail form��
�� ��.������Design'��Equity �C�[�#-.�����(�3 

�� �>.��>.���"�������7���.����|View�5&� 0����Presentation View ���2 ?�6�� ��Slide Sorter �
�&;����3 

�� ����:;�A�N��������+&�������������C�F,-�(�3 

8��.����������9��

��������_����-���N�������������������C����&��������)��#��2 ���� N>���� (���T�����A;��� ((�)���� (��K #���������A;����
��<o6��Y?�y����������/�%��A;�����(���3������������	C���.������FL�������-��A��C��/�%��(�����J��-��&�5��C�D���

�������C�H(�3��

��&����FYI������7��������A;�2���W�x��-��D���C�[�#-.���(��3��� ��������{&������- ��[� #-.����� )����� ����5��*- ����
�����1b��

• ��!�#�,����������A�N������>.���������-������)�����I�<�6�(�	C���(���Shift��������(�����&��- 1����8.���
	C����5��*-�����(�)��A�N�����.������<�6���>.��C�[�#-.����(�3 

• +�-&��������&���	C�F�����>	C�(�C�D(�3 

• �+-�*�����������0���I������(���A�N����&���>.����	C��� 	>J�� (���Ctrl�� �����(������ ��&��- 1���� 8.��
	C�d&��(�C�D(��3 

• !��.�/�0���������&��')����2K���������	C�<��0�����(�C�D(�3 

• 12�3��� ������� 45�������������.�������Outline 6�.����� (��Slides/Outline� ���������
��-������������B-.���������C�f���d&���(�3 

• ����6�����������	C�(&��D�	C���-��5�.���B8.�(&��D�� Select��5&� 0���Editing��� .�������
HomeU0�[�#-.��&�����Select All��5�.���B8.�F:����-��FC�[�#-.��n��������13M���5��*- ��

	C���(��Y(�����Ctrl+AR 
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����������-��[�#-.������_����J��U8�����J��-��A��C��/�C����� �����2A;��������� ���C�H� (��3��� ��������- ��<o 6�
	C��L*
����5�1�[�#-.�(����(	�Delete )����K/����(��3����	L������-��+�,-.����J���� >C��������� )��

Cut�Copy �&�Paste.�!E6����(�5&�0�������Clipboard��.�������Home�C�5��*-���(��3��

���
����T���T?���-���:��C(($��5�1�5�����(-E)�������� ��-�����U ������ .���� ����}(Quick Access)��
��&��>C�Undo ��(����(	�3��

:�� '�����;�<�;��=�>��	
���4�����

�����������-��4����5�.���B8.����5��*-������5&��������)���-�����C����A������C�5��*-����3���������
��.������������Insert5&�0�����Text�&�����>C��Text Box	C�(�C�D(�]/�����m�����?�:��������

��d&���A��C�f���������-�����C�����:�5��#?��5���.�������C����(��3��

������ � � ������&��D(	C�����_���C�����
���Text Box���������������?� :���] /�D ������ B����d&� ��f����� J
A��C��/�%�����������C��(�C�D(	C����� ����������-���������- ��A;����� C���1����� ����� I�V :�D ����&��� (0

����((T��A;�5���.���-�����!���-������3 

�����-�����C�4�������_����������-�����C�&�5�1�+�_/�4����8.�K.�������� 9�V:�FN1����(�� �������;� ����������� C��� ���
2?�6������-��A������������C��/�%�����C����������&����A;�F:����-����������>.�7�3��KC�������>%��� � ����G��� �(�8-���A�(5���)��

�����C������J����T��5��#?��������A;�5���.��A���((����� M�FN1OePQR3��

��
342��#���A������5����

�=>)(����A�N��A�������I�������&���>.��8-���(����� ���i .��UY��5�������� �-����� C�A�� ����������@ 	-#��$� BJ�� �����
�.�:�93��

��8-(5���) 

8-��(�5�7:�9 
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����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

?���&��%%@�AB��%�C�D+�=��

����T��((
��:��(�)�S�FN1�$��-.�/�����2���5�1�+�>����-������C���� .����Home�5&� 0����Font ��
&��������.������>C�������&����(���������&��A�N(�����������&�5�����(	��A;��������U0������.����������(���[�#-.�����
M�FN1OgPQR3��

��

��
�342�$����1�
��Font���

������ � � �������1����2E(?����5��*-������5&�Font Size������ ���2 .�/�5��� .��7)� C�� ��7��U/�������������A�� �
)��U���2.�/�5���.��7��U/����(Increase Font Size)&� �2.�/�5���.��7)�C(Decrease Font Size)��C�5��*-���3 

���������T�((
��:��(�-��$���

�� ��>.�D�?�:�7�����C����(��3 

	� ��������?�:����������-�����C�D����C��/�%��(����$��Y��&��"�.����������������U/��W�.������C����! 	y���"�����
����C�H(�3 


�� ���.��5&�0����5��*-���������2.�/�5Font��.�������Home����^Q T�(()���(�3 

�� �������2.�/B Nazanin�Y���	C����&�5��C�F(&��D���(������&��A�N(���Font Color��-��i.��
����;�i.�����T��(()���(�3 

�� �����-�������C�[�#-.�����5�1�H(���	C����&��(�&��D����(���������&��A�N(���� �����>C���(���] /�'��� ��(��
CU0��)�-C��������)��C�A�L-�������A;�@	-#��(��M�FN1OlPQR3 

T�((2.�/�� 

T�((2.�/�5���.��� 

�U/��2.�/�5���.��7 
2.�/�5���.��7)�C 

T�((2.�/�i.��������(��Z�]/�'(�)�-C���C�� 
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�5	��5���@�I�J�<��A7���

�E��&��%%@�AB��%/��F���$�C���


��:(�����������v������-��<��0���������C������"������1����5&�0�|Paragraph����.����Home��T��F��I�((��2����
M�FN1OqPQR3��

��

��
�342�6����1�
��Paragraph 

������� �
��������!��G4���WordArt����H4���������HI5�J�H*K����H!��

G�+�=�������4���

����5�	J�+�>�����)�U-.�/����.��������-�����Format��5&�0�WordArt Styles�C�[�#-.�� ���(�M� 3��J��
1����-1��(��.�����Format.�������-���F��I��A�N���C�2����&���>.����-�������D��1���3R��

&����(��A�N������&(�����1�0�����C��(��5&�0�2����2>���WordArt Styles��5�)�K����	C����1(�D
�?�0����&�5��C�5�	J���)����J����N��C�[�#-.�����(��3 ��

���(��Z�]/�'(�)�-C���C�� 

0���I�2BJ(��Z�<��0������- 

?(2E��Z�)
5��>1�&�2?�� 

����<��0�����Z���->)
�"��������B8.�J��

�k8-/�������,�
<��0���� ���	
�/(<��0��������
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����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

������ � � �������?�0WordArt2���7#��&���������3�7#����Applies to Selected Text���5� 1�[� #-.��5�	J�
5�1�[�#-.���C�<��0���������K#������B�����+�>�������1&��7#�����Applies to All Text���-��<��0�����FC����

�+�>����� ����13 

2>EI���Text Outline T��A�N���((��')��/�5�1�+�>����-�����2N/�����)��:����I�&���1(���i .���� ���
�T������-���&��v�y:�j�.��((��)�(�3��

��>C�����5��*-�����Effect�5&�0����WordArt Styles�����5�	J�A����)�����������.������(Shadow)��
����[���������(Reflection)�8-:&�/����2?�6���(Glow)�_�����7:�9����(3-D Rotation)T��&�((��
���)�FN1��(Transform)���C�+�>������M�FN1QtPQR3��

��
�342�:����1�
��Word Art Styles  

�������U-.�/�5�	J�A��������&��-�����(��#K��'<��0�����$��

�� �>.��7Example1�+�w������C����O���������6�&�������� ���D��� 1���My Presentation Files�
-:��(�������C�(�3� 

	� �:;����������A������Outline Tab�C�[�#-.�����(��� .�������5��*-������&��Format���5&� 0����
WordArt Styles&�����(������&��A�N(�	C��(�C�D(����8.����&����&��d&� ���- 1��)�� �����D

5�	J�A;�W�.��)��C�5�)�K������)(�3 


�� �7#����Applies to Selected Text�5�	J��Fill-None, Outline-Accent2�C�[�#-.�����(�3 

�� &����(������&��A�N(��Text Outline 	C�(�C�D(�������&������ �;�i .��5� 1��������[� #-.�����
�C(�3 

�� �7#����Content[�#-.�����<��0�������������&�5��C��V�&��� 9(� �5&� 0������Paragraph ����
�.��� Home �C�[�#-.��(��3 

 

Text Fill 

Text Outline 

Text Effects 
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����	
����������(Slide Master)��

����8?��� (Slide Master) ������
�:������-*0����8?���C���1�	
������W�>����)������5�1����
��>.�����2���7�3	C(�����%��������������C�����8?����.�1������������W�>�������C��:���"��5�)�K���)�

�����1�3��������5��*-�������-6������5&���8?��������n������C���������� N��$��� %���A�1�A�EN������d��;�F w��
��>C���W�;��)����������&��&�����YI��(������FC����F��)����>.������������ �����> %��� 1�� )��:�7�������������� � �G��� � ��� � �� � �� � ����T��� ((����F C�����

����/�C��)����������������.������j�%���2����������T���8?���((�)���(���������FC����j�%���A;�������T���)�((��
��C�3��

���PowerPoint 2007�>.��)�������7������8?������2���b��

�� Slide Master�������>���7#������������D����9��Master��2���� >.��C���)� S����F L���
0���I(��1��(����&����������(���W�>������)���>.��_�����7((�������C3 

	� Handout Master������Master�>.���)�S������_��~�9�W�8�)��������)�((�������C3 


�� Notes Master������Master�>.���)�S�����0�21�����_�����5��((�������C3 

��� ��� ��-������� ��Slide Master��� .�������View��5&� 0����Presentation Views&����Slide Master�
	C(��C�D(��3�6�.���(���Slides/Outline��9�W�>��(A�����)��Master�����5����A�K.������ 1�3� ?&�(�9��� (�A���
�>.��Slide Master	C����(9��(A�����>.�����)�T���)�&�2���v�����7((	C����A;�����(9��(A������ )��
�>.����+�>���7���1�3?�6����9��C�(A�����)��_����C�[�#-.������ (�T��� )���� ((���! J���� B���A;�����

��((T��������)����>.�������7��9��C���1(.�����.�������K���MFN1�QOPQR3��

��
�342������1�
��Presentation Views��

������ � � ������>.��&��D(	C����Slide Master���W�.��������J��.���Slide Master�H9�2>�����Home��/�%��

�����&��D(	C�����C���1Close Master View���>.����Slide Master��4��:�������1M�FN1QQPQR3 
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����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

��
�342���������@��Slide Master 

��������T��&�5�)�K�((�������8?��� 

�� �>.��7Example 1�C��������(�3 

	� ��.������View�5&�0�&�Presentation Views&����>C��Slide Master 	C�(�C�D(��3��������C��
��.���Slide Master��.����H9�2>����� Home���/�%������13 


�� �����&��5�����H9�2>�����?&��(�������	C��(��C�D(��3���� �������	 
������� >.��������� )�&�2 ���7
T�((����A;�����C���C����(���W�>��������1��)��:�+�>����)�3 

�� ������(�����������7#������Footer���$��Y���"���{�&���&�{���;�$���&"�����������C�H(��3����������� C��
�����W�>�����$��Y�����)���>.���>���7�1��)��:�+3 

��

������������	
����

WordArt Styles 

WordArt is a gallery of text styles that you can add to your 2007 Microsoft 

Office system documents to create decorative effects, such as shadowed or 

mirrored (reflected) text. In Microsoft Office PowerPoint 2007, you can also 

convert existing text into WordArt. You can change WordArt text like you 

can change any other text in a shape. 

Slide Master: Slide master is part of a template that stores information, 

including placements of text and objects on a slide, text and object 

placeholder sizes, text styles, backgrounds, color themes, effects, and 

animation. 

The following picture shows a single slide master that contains three layouts. 
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�!9���:������ ���;�<��) =/>�"� �!�>���)�	�����!�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

�L�.����+��
Apply A������C�����

Background �����(����
Character Spacing ���	
�/(�)�-C���C����
Design k6��"��

Drag &Drop KC(�-:��.��&�A���
Edit &����7��

Footer �L*
����
Header F�/�����
Home �.�:��

Picture �������
Slide Master ����8?�����

Tab �.�����
Text Box k�-�����C��
Theme '��� ����

Title�� A������
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7��M���@	B��
• ���PowerPoint�  >.�A�  N����Z�  >.���  B9����7Normal �Slide Sorter ��Notes Pages&�� �

Slide Show�������J&�3 

• �>.�Z�>.����7���(Slide Show)�����������>.����5����Z&��A�Y"�#�����7�
���>.��L*��7
k��5��*-�����13 

• ��.�������5&�Slidesk�����.�������A���Outline.�(���U�����/�%��&�������7���3 

• 	��I(����W�.����k-Zoom��21���A�N���������������������� ���F :���$��� %���A����A�K.���U�����')�� /�����
k����C3 

• (9��A���MLayout�R�����)���0���I�FL����� (�� 1��Z�(�������#K �����A;�F :���Z���k ����� �C�3��� )
9�(�5�.���B8.�Z���_��Z�����A��MPlaceholder�R2��3 

• �k6��"�Z�8?�(Design Template)h�"�����5���;�Z�)��Z�����-*0��kBJ���F��I�7#���C���1
����Z�UJ������>.�D���YI����7�i.��F(�(�������W�/���)���B8.�J�j�.�&����_��������A�-��k)�?��� (2E���Z� )

2����������5��>1������Z��(E��&������������������8(�A����$�>����� ������� �(������� ����&�k 6��"�A;����7(�'
2���5�1�3 

• '���h�"���)��������Z�)(7��-:���������>����C���-E)�Z����2.�/����Z���i.����)���!?�I�&��)��Z� ����������� )
����Z�)�S�2(��oJ�n�����Ck���)���.�1���.�������3��

• 
��:��"����<��0�����&�2.�/�$�(��.����|HomeT��F��I�((E)����-3 

• �Z�)��U��WordArt 5�	J�+�>���A�N����k��')��/�����-�����ZU-.�/�Z�)���&;3 

• ����8?���(Slide Master) �������k���-*0�k
�:���� ���W�>��k	
��Z�8?���C���1��Z�)�
���>.����5�1�����2���73 

��
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����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!���B���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

�N+�<���O���
�� 1��+�&%�6� &�7��%�&�8%�9����14���/%�&�,��$%�&�%/�:�;��)�$�3�< 

=2����WordArt� � ����Text Box��  � �>��Smart Art� %���Book Mark 

	� 1��8%�9����+��)7�6� &�7��?�3@�87� ����AAB��;��)�<%3C 

� �=2���Format�� ����Home���� �>��Insert������� �%���View 


�� �8:�.Themes<?���+��)7�6� &�/%� 

� �=2���Format������� ����Home��� �>�Design ��� �%���View 

�� Handout Master1��6�D���;/�&�+5��< �% 

� �=2��_��((�>.����)�S�������~�9�W�8�)��)���

� ���_��((�>.����)�S�����0�21���������5�� ���

� �>�_��((�>.����)�S��0���I�FL��&�(��1��(����&����������(���W�>������)���>.������7��

� �%��_��((9�5�L.��(1��A���(�����������

��  &�7��3E2�� �������F)�;��)1��8%�9����+4�G.�6��<%3C 

� �=2���Close��>C�����Office��������������������� 

� �����>�� Close x������5�������

� �>��Close Master View�.�������Slide Master  

� �%���Y(�����(	���Alt + F4��

�� '��+��)7�6� &�7��8%�9�����)�<%�%��AAB���/� �����+4A�7�H0�I�/�$�3� 

=2���Format������� ����Home��� �>�Design ��� �%���View��

7- Which one is the best view for organizing your thoughts on a presentation’s 

content? 

a- Normal View ��
b- Slide Sorter View��
c- Outline View 

d- Notes View 
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I*K�<���O����
�� �>.��J�7�������C����(��3 

	� )��#?��'��&�������>.���>���7�C�+(�3 


�� ����J��������9�&�5��C����(�������A;�A���Tow ContentT��(()���(�3 

�� .�������������������.�������5��*-������&�5��C����&�A�����5�.���B8.�������Format����������5� .���B8.������J����-���
!?�I������C�(��3 

�� ����J�������(�������W&��&�+&�����C����(�3 

�� ��%���#-.��5��#?���������C�[�(���������&��������C����C�����������������C�5���;��(�3 

�� �����(����(�C�+�>����)�����Z&��@	-#��i.��&�����!C���Z�3 

�� �>.�K�5��C�5���;��C����������>.�����Slide Show ��� ������&�5�� C��� J����)������� J���(�� >��7
�C(��3 

�� �������_���>.�������J��A���>.��&�5�1�4��:�7�>.�����������(Normal)��0�����3 
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�� �����������	�
�����������	��	��������������� 

�� �����	��������������Clip Art���������� 
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Change the data in an existing chart 

If you create a chart for your presentation and then the data used in the chart 

changes, you can update the data so that the chart is accurate. 

1- Select the chart that you want to change.  

2- Under Chart Tools, on the Design tab, in the Data group, click Edit 

Data.  

Microsoft Office Excel opens in a split window and displays the 

worksheet that you want to edit. 

3- To edit the contents of a title or data in a cell, in the Excel worksheet, 

click the cell that contains the title or the data that you want to 

change, and then type the new information. 
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���Edit Data�����������       ����Switch Row / Column���

5- You can edit or format a chart object using any of the following methods, 

except…. 

a- Double-clicking the object. 

b- Right-clicking the object and selecting Format Object from the shortcut 

menu. 
c- Selecting the object and clicking the Format Object button on the Chart 

toolbars. 

d- Click the chart Object list arrow on the Chart toolbars and select the object. 
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�� �����(�&��\�/���Custom Animation ����������\�/����'���$4���*4�9��h���	����	���

�=O��c��f&��	�$&vXY�,%�@�����  

�� ��$	)"����������$&���Effect Options��$4�3�1������ �������-7&����-4���4�B	���Diamond�

���
	����&�������J�=O�wXYK� � 
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�� ���������Effect+�����5�������=��k&�����������4�Direction+��$	)"�Out��$4�3�1�����  

�� ��$	)"�=��k&�B�	�����������O������Sound ���?�����,4���*4�Wind��$4�3�1�����  

��� ���������\�/���After animation��$	)"�Hide After Animation��$4�3�1�����  

��� �����������Timing+�������$	)"�=��k&����4����Delay+�a����������������-����	�-���	����-'���$4�9��:�������x�a�

'�����xl�,(�,�>���  

�	� ���4�����OK��$4���*4�� ���Z�*;���4��Play���\-�/�,	�����Custom Animation��
�-��

��$�N����������F��M,��b'�
	���  

���� ����	�����	������������0���������������S$'���$4�T������'��������9��:���&)�%���0��-������-������

��������5������Timing�	����	���+����2C�h��i����9��:����� ��

�������	/�01����&)*��)2/(Action Button) �����������
��4����%��'��*�:��+���4�����%�������4��$�\%��	���0�
��������?�>�=�:�P,G��<��,����������-����G,"�,S������%

��y��$4�P,G� ����,�������&���4�������&�����4���$4�&��,���%� Office ���-&�z�-j�'���-%�� ����-���N0���o�� � ���

B�/� �&���F	��4���	����&��,������\�/���$4��%� Office ,%���������B�G,"��,������4��� �����4

�&��,��+�%���&�����4���	���������������-&�z�j�'��&��,���<�����-	���+�-%�� ��,-� ����B�-/���-���8-"���

��4���	����	�� Previous ����$;�Z�*;��-�,��9���	�������'��� �����-�4���-��,-�2��Q-����,-%�����
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	����(	�/������6����	��0�"�������7,���������������������������������������������������������	����(	�/����%�*�.*���0����
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� ���

���$4���N�'��	�����������4���	���������,%�����'���D������������+�	����	���B�/�������-	�,�� �-�������-0

��'��*�:���4��9�{&��First���*4�����4�����<�+�&�
	�����	���B�/�����'��*�:���4���	����	Forward�

������&�
	������������	����4��%�� ��������	�-������'��*�:���4���	���,4��G�j��,�+�������)-��Shapes�

��������Insert���,"����Illustration9�O���\�/��������$4���*4�+��\�����Action Buttons+���-�4��

���$4�3�1�����,S����&��'��*�:J�=O�|XYK ��

��
�231F�!Action Buttons ��

�����!��� "�# $%�%�&'��(���

�	�,4���%�8&��E��$C+�
1�����Action Buttons���-4������G,"��,���'��*�:���4������7&����'�

���������N��,���4���%������&��'���#��(����BO�&� ��&���������'�-�*�:���4������'����������-������->���-������-&��

���$4���F	�`*�1&�����������5��� ��'�-�*�:���4�����h���	�=	�N'��,�+�������,-S�����-&�h-���-���

��)������QU������$4�3�1��Action���,"����Links���������Insert���	������*4�J�=O�}XYK� ��

��
�231-�!�0�
��Links ��

�����7&���4Action Settings���%�8&��&��&����4�B	�����4�������'������9�-�:�����->�,S����-&�=�:�

��$4�J=O�W~XYK ��

�����7&���4Action Settings����������+����������������Mouse Click�&�T�S$'��'��*�:�������4����

�&���F��+h������d��&���*4��������������,�"Mouse Over��'��*�:�T�S$'�&�����4��������d��&�

�&�M��?�+�,�"��,��h�������,	!� ��

��
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�231�.��!�0���?�����<�Action Settings��

�$	)"� ��� ����%��������(�&����� �� � � � � ���������%���$'��N:����� ������ ��m����

None����F�����4���%��� �� ���� ��� �� �� ���8� ���

Hyperlink to���=�:����������� � � �� ��� �� ���?�>�&�3�1����������\�/����4�� � �� �� ����� � ����� � ������� � ������� � � ���

Run program���&��,���,(� � ��� ��� �� � ����%������$	���7'��	,(������ ��� �� � ��� ��� � �����

Play sound���
1��� � �=	�G� ����3�1����'�?��� �� ����� �� � ������

Highlight click��B���� � � �������-$�&���-��,'������ � �� �� � � �� ���-4�������-����-��^N',-&��-$	)"�B-	��-��������������� � ���� � �� ��� � �� � �� � �� � ��� � � ���J�����,-���-$	)"�B-	������� �� � �� � �� � �� � �� �

Mouse Over���.��$&�� � ��� � ��� � �K���

��� �����'��*�:���4�Beginning ������5����������Action Buttons��N�����$4������ ��

3�����&'�(�)*������4�5�/���+����4�"���

���*�����*�(���� ������� �� � ������%���&��	�����!(�,���4��	� � �� ������ ���� � �� ��� � �� ����	)G� ��� ��+���*(�9��:����?�H����� �� �� �� � ��� ��� � �� �� ����%����'�?���� �� � ����� � ����4�B	�����4����� �� ������� � �

�&� ��������&���,�2�����������'������ �� �� �� ������ ����� �� ��������,4�=k�$&�.0�1&����,',x����� � � �� � ��� �� � �� � �� ��� �� �� ������&������B	������� � ��� �� �� ����������	����?���'��� ������ �� � �� �� �������
	�����������$$4����� ��� ��� ������� ���
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	����(	�/������6����	��0�"�������7,���������������������������������������������������������	����(	�/����%�*�.*���0����
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� ���


	������#$%�����	���)G� ��� ��� �� �� ��� ����� � � ��+�,4�
1����V�j�&����.��$�&��k���&�� � �� � ������ � � � � ����� � ���� �� � �� � � ��� ���


	��������'�?�=	�G��	���,4��G�j��,�� ��� ��� ��� �� � �� ����� ��� � � � �� ��� ��� �� �+������������ ��������Insert���-�4���������� � � � �� � ��Sound����,-"�������� � � ����Media Clips��

��'���$4���*4����� ��� �� ���,	�� ���=O��c��f&��	�$&�� � � �� ��� � �� �� ����� �Xq�������%�8&�� � � ��� � �� � � ���

� �
�231����!�*7D�
���Sound��

�&���%�8&��$&�B	�����E��$C� � ��� � �� � �� �� �� ����� �� � �������&�c	,0���2C����+���� � �� �� � ���� � �� ���� � ���������G�j��	�������?���'� � � ��� ��� ��� �� � ��� ���� � �� �� �� ����

�� Sound from File��3�1������	)"�B	&��$���G���'	=��%�'�?����U&�-4������-(�&�����-����,'�

��	�,4��G�j��  

	� Sound from Clip Organizer����������5���	)"�B	&��$��*4���'�u��%�'�?����(�&�����

PowerPoint��������,F$���������������,F$��������������4�	��&�����
�����+����-����	���G�-j���

��,4	����9�I'�����	&���,�$���'*4���u��%�'�?����	,#����	�,4��G�  


�� Play CD Audio Track��	)"�B	�G�
1����O&��$	'�?�=�������(�&�CD��,-(���-#$%���

���	&�T%,G���
���$4  

�� Record Sound�����5��������	)"�B	&��$���?���'�����������,4�^Nj�����>�	��)G��  

�������� � ���������	�����������?��O$���� � ��� ���� � �� � �	�������G�j����� � �� ��� ���+���	��<������	���"�$*��BO�� � � ����� ���������������� ���� ���+��������������� � ��� ���	���&��G�j����� �� ��� �����������-�N/��-4������������ � ����� � �� � �

&�����������b'���1/��������<�,%�@���'������� ����� � �� �� ������ ��� � �� �� �� �����������,���� �� ��	������������&��������<��������� ��� �� ���� ����� ���	��������<�����2$���/�D����
����� �� ��� �� �� ���� ��� �� ���� �����*4�=-����������� �� � �� ����-��������

�����������	��<�B����	����������BO���� ���� �� ������:��� �� �����J�NormalK���	��*4����� ���������������������4������ � � � �Preview������,"���������� � � ��� �Play������������� ����������Options+���

����%�>�
1���?� � �� � �� � �� � ���� �� ������������� ��� ����� �	��
��(Slide Show)+�S$'�cN0��?�� ���� �� ��� � �����*4��-����-����F��M�������� ��� ��� � �� �� ���� ���-����������������

<�	��BO�� �	�����������&�
1����4��>�M��?��� � ����� � � � �� �� ��������� � �� ����

�	�������?������G�j���� �� � ��� ���� � �� � � �� ��� ����+��������� ������Format ����� �Options���������� ������ �����%���&��G�j��*?��� ��� ��� ��� �� ��������� � �� ����������5�-���-����������� �� �� ����

�������� ����Options&�� �������,4�T�S$'����?�BO	<���������?�
1����&����'�� � � �� �� �������� � �� � ������� ���� ��� � �� � ��� �� ��� �� �J��=O��� � ���� �Xq�K� ���
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�231����!����4��Options��

������ � � ���������-$	)"�3�-1���M��-?����������� � �� � �� �� ����� �� � ���Hide During Show���-������������ � ������ �Sound Options������-&������-?�B-O	<��������� �� ���� ��� � �� � ���

����%�1��������8��+
	���� � �� � �� � ���� �� �� �� ���� ��� �� ����$	)"�3�1���B�$E�%�� ��� � �� �� ����� ��� � �Loop Until Stopped+����'��'�?�=	�G������� �� � �� ���������	�-���-4����-&�������� �� � ��� � �� ���

�����9��G� � ���� �� �+�&�
1��� � �� � �������� � � ���

�����
�����)G�G�	'�?�=��������	
���

�� ���F	���	�(�
	�����$4����������Insert ���,"����Media Clips���4������Sound*4����

$4��  

	� /����������\+��$	)"�Sound from Clip Organizer ����4��'���$4�3�1�����Clip Art,%�@��

���  


�� �4������Clip Artu�*4����O	�������%��$4���*4��'�?��� ��4�B	���+���=O-��c��-f&��&����

WiXY���&���%�8&������$	)"�+���Automatically���������?��'���$4�3�1������������
-1����-4��>���0

���� �&��SD�&�����BO	<��4���$4#����������	&��G�j�������  

 
�231� ��!	�A�GH���I�7IJ�/�������<���

�� ��4��Clip Art�������������	�$N����Options���,"����Sound Options+��$	)"�Hide During 

Show����'���$4�3�1�������8��������8���?�BO	<�
	�����,(���&���   

�� ���*4F5����'���%����8G����	����,(�
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0��,1��89:9;898;3<�����������������������������������������������������������������������������0��,1�:9:9:=3>�3?!������

� ���

��� �����=	�G����O	��� �������� � ����������4������(�&��'�?���%������ ��� �� � � � � �� �� � �� ��&����������-{&�
	�-����-������-','��U�������������� � �� ��� ��� � ����� �� � �� ����9���������������,-4��G�-j���������� ��� � � �� ��� ��

��$	)"��,���4�� ��� � �� � ����Loop Until Stopped���,"������ � � ����Sound Options ��$4����,����� ��� �� � �� ����� ���

(��)�*��+�,-. (Record Sound) ��

3�1������ �� ��������$	)"��� ��� � ���Record Sound+����&������[C�;��,F$�� � ������ � � � � ��� � ��������-�;���-;���-�������� � � � �� � �� � �����-%���������,-F$��B-	������-(�&����������� � ���� � ���� �� � � � � ��

�����M�?�^Nj���#�������8&���,[*�:� ���� �� � � �� �� ���� �� � �� ��� � �� � � � �� � ���

����&�^��'�����>���?����� �� � � ������ � � �� �� �����$;�^Nj�BG�,[���� ��� �� �� �� �� � � � �������&��'�?�=	�G�^Nj���Q������� � �� �� � �� ����� �� ����� �����������-�;������Z�*;��������'��������� � � � �� � ��� ��� ����� ���� �Play��

�	�$8������>���?� �� �� ������ � � �� �� � ������;������+�	�������'�?�=	�G�B	���,;��G�j��,��� � � � �� � ���� �� � ��� ��� �� � �� ����� ���� � � � �� ��� ��� �� �OK��$;�Z�*;�� ��� �� ��� � ���

������ � � ����=	�G� �������&��,������;��'�?���%�� � ��� ���� �� � �� �� � �� ��PowerPoint�&����5���� � ��� �� �� ����o���D������o�� �� �� �� �Q$(����	���� �� ����� ������*.wav�$����� �� ��� � 
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%�"� ������������ ��	���
���	��*4����� �������u����	���	����	� ��\���� ������"����� � ���	���������,'����� ������ ��	���$C�
�� �� ��	�����B�� � ���	���+�����������9�-k���.-0�1&��-������-25&���������������� �� ����� � �� � �� � ����� � � � � �

&������%�� � �� ���G��	�=������%��������� �	���	����	� ���	���,0������� � �����	���%�)��c��� ��� ����������� �	�F�����������$��&�9������� � �� ���� �� ����B������%��������� �	�F�������9����� �� ��	��&��G��� �� �������������� � ��-	�������

�G�������	�=����%����������(�&���� �� � � � � �Media Clips&�3�1���� �� �� ������������� �� � ���

,��� ������G�H��������� �� �	�=������%��������� �	���	����	� �����%�)�����4������ ��� ������� � �������� �	�F�������9����� �� ��	����������%��������-���G�������� � ��� ��� �� ��� � �� ���-	�����U&�-4��\����� �� �� ��������-(�&�,'������ � � � � �� ��
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	�������1�����&����k&��	��� � ���� � ��� �� �� ��� ��� ��� ����� �� ����� � � �� �� �����-��,����� � �� �

�C�,#�������&��B	���$4� � �� � ������ �� ��� ���� �����k&����� ��

;����9��) �"�-'�������(Set Up Slide Show)��
����PowerPoint��$	)"���%���kN0��5*�1&����������$���������&����&�B	�T�S$'�����;�����������
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�#'��7Show type��

,"�T�%�1���%�	��������M��?����'��75? (Full Screen) 
	����T�%���;�
����P,-G��T-%��B�-�%�

�$	)"��� Presented by a speaker (full screen) ��9��G��&�T�$;� ���B	��/�D������Z�*;���Q�

�������� Slide ShowZ	��,����%��*;��'��*�:+��������B�	���uC���%�8&�+�75?���-%�>������-�

���&���$$4��	�������O&���%��*4������'������$4����5���d��&������� �E��$C��T�%�-1����%�	�-����-���M��-?�

�,F$��
	�������������$	)" Browsed by an individual (window) ��3�1����&�T�$;� ��-���3�-1�� 

Browsed at a kiosk (full screen)��/�D�
	�����$��&��$	)"�9�+���'���75?������%�>����B	�M��5'�

�;����B	���,(��/�D����O&���%��*4���d��&������5�����O&����������4��>���0��������(������ ��

��
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�#'��7Show Options��

�E��$C�T�%�1��
	�����%�	������+���'�������M��?���������,['�����"�$	)Loop continuously 

until "Esc"���3�1����&�
	����+T�$;��%�	����'����&���;���*; Esc ���75?���*;����8-G��������-��

�&���&����	 ����M��?�9��G��$	)"������Show without narration+���-����	���-%��'�-?�����-;�����N-����o� ��

���̂ Nj���$$4��	��^��'����+������#$%������
1��,(����%�1���� �,��^Nj������	���%��'�?��+����������

 Slide Show��4� Record Narration ��3�1����&�T�$; �����7&���4�Record Narration��������8-��

�&���� �����������4�����=I�&�,'��U&�4����BG�,O�&�,"OK����������������-��,-(�
	�����'���$4���*4���������-��

������9���	���������,&�M�7�j�'���������G����������������������
	���������	����'���$4���*4��	����*>�

���$4�9�N���
	������	����'��������B��%J�=O�a_XYK ���
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���
	�������'���Q�+��������%�>���%�8&��&����J�=O�avXY�K�&���:��4������	��$4��%����-���'�-?��

������,�>���	���,%��,�%��������&���,�>�����&���������������������F����$�+������&�9���-�,�� ����'��-?���

�����4���4Save�����+��$4�3�1�������&�� �� �����$�� � ����	�(�+����&��B	)#	�(�����&��*N����$���������������-�*4��-������-�

���4�Don’t Save+�����	��2$'���%�&��G�j�+�'�?�����&�������������-%�>�=-N��M�-��S$'�cN0���$�

��� ��
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	��������-���B8-�������-$	)" Show without animation ���3�-1�����-&��T�-$;�����-E��$C�

T�%�1��B8������%���#$%������%�	���,(������B	���������$	)"�9��G,�n�����  ��

����\�/ Pen color ������1/�����,����*���;���#$%�
	������	�-�+���-&���-�%�>����5�-�����-�$;�

��$	)",� ����5���� Pen Color ��#$%������,��'l��;�����M�:�j�&�T2&��	������5����&����� ��

�#'��7Show Slides ��

,"�T�%�1�����'���%�	���
	������8������������������B�-/����	�-�����������-; From �������-��

B	,><��	�����������; To �����&�T�$;+����0���9�{&����	���_��'�Wa ��

�$	)" Custom Show �,������5����,;��
	����.�','����>�&<��<����&������N���4����%�	��� ��� � � ��� ��� �� � ��� �o� ���� � �� � �� � �� � �  ��

�#'��7Advanced slides��

,"�T�%�1��
	�����%�	����7'�9,�$;���&��>��������-$�	���-���Z-�*;��d��-&���-	��������,8-G��-���-�*;�

Spacebar�B	���;�M��?��,�"��$	)" Manually ��3�1����&�T�$;� ��

�E��$C�T�%�1���	������M��?�Z�'�&�'�����(�'� ��������&��B���'����-����,-���
	�-����,-%���+�	�-��

��8�����������$	)" Using timings, if present ��3�1����&�T�$;J� ������&���&���$��z�-j�'���N������ �� � ��o� �����

������K  ��

�89�� 7��%�:!��%�;<=!��

,"��U&�;,'�����������$C Monitor ����-&����5���
	�����	���,�����4��,�����	����-�$4+�����-	���

������Presenter����$4����5���� ����������������B�N0�-1&��-4��/�-D������,'��U&�-4����
	�-���9,�$4���O&�����B	+�

�����������
	���Slide Show��-&���%�8&����-$$4+���-&�T%,-G�����<� ������-4�B-	��,-�����\-�/����-�����

Display Slide Show on3�1�������>�,S�����&�,#8	�������-�$;J� �������-4��'��-?�����-2$'��\-�/�B-	

�����=I�&�,#8	����������=��D�,'��U&�4+���9��G�K��

����-$	)"�3�-1��Show Presenter View����\-�����Multiple monitors���-&�.-(�&��������
	�-�����-�

������������,'��U&�4Presenter��%�8&�������� �����B	+�����	���
	�������%�)���&��,������-%������9,-�$4��,-����

������-&���'����>����
	�����	�����!-"� ������-�����Presenter+���-����	�����������������-(�&��-$�&����'�-?���-%

�	����%�&���%�8&������ ��

��
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�#'��7Performance 

�����S$&�
	)G���:,-���+
	�-�����-$	)" Use hardware graphics acceleration ���9�-�G���-&��T�-$; �

B�$E�%����B�	�������<���5�;��	��(�����j��
	�������\�/������ Slide show resolution ��:,-��
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	)G������&��$;� ������)�������5�����Resolution������,"����Monitors��������-(���T�-S$'���O&�)���

��2&���j��� ��

�<���=>����������	/-2(Hide Slide)��

����PowerPoint����������$%�1������
	�����51&���%�	���+�������	�
	��������������:�M��?����B	,��$��

������	���	�����	����$C��	+��&�����r!D���(������'��	��Delete��%�	���+��<�����������<����-51&��/�D�������%� 

,S����&���%�	����	��	���3�1�����Q����4�B	��,�+���,"����Set Up����-������Slide Show�����

��)�Hide Slide��$4���*4��J�=O�awXYK ��
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�231�E��!�	;4	�Hide Slide �0�
���	�Set Up 

�����	�����,4��51&���Q�+�PowerPoint���������&������51&��	�������������^>��	���������������4��84

Slide Sorter��������Normal������%�8&�=����J�=O�a|XYK ���
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������ � � �����<���,4��51&��������%�����)�����%�	�����,4���,&��&���F���%�����  

����������	�����,4��51&���
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�� ���\-�/��Custom Slide Show+���-$	)"�My First custom show��-4�����9�-{&����_����-F	�

�	�,4+����,(�
	�����'���$4�3�1��� �J�=&���
	����B	i����	��� K 

	� ��*4�Esc�����%����8G�/�D����'��	���H��>�
	�����,(�  


�� ���������Slides��$	)"�����,4�������*4������	�������Hide Slide��$4�3�1�����J� ���-	

����������Slide Show���4��Hide Slide����$4�3�1��� K��

�� �&�����
	�����	����$C���$�N������$4�,(���
	�������  

�� ����*4H��B�	����������������$4�,(���
	����,#	���������	����#�� ����51&��	���
	�����:�����4�B	

�&����  

�� ���*4Esc��%����8G����	���H��>�,(��/�D����'��  

�� ���	������-	������,4��51&��4+������-�$4�3�-1���������-�4��Hide Slide���-�������Slide 

Show��$4���*4�H��>��51&��/�D����'������  

�����9��) ����?���@���	/-2��1�@����

�������4��N/�(�M���O&����O	PowerPoint�����&�,���4�����>�������!"+����������
	�-����-��M�7�-j�'���,-4��G�j�

��+�������	��������%�1���I1���4��&�#$%�������$�N����
	����=	�G���$$4+����������	�-���-�4�M�7�j�'�B	�

����./�f&�T2G��� ��

j�'���,4��G�j��,��	����	����z� 	��	��������h���	�+,S�����&�h��3�1�����Q��+��-���������

Review����,"���Comments�+������4��New Comment*4��$4������4��������&�,%�@��4�������-�

j�'�������$4�������h��������,&�M�7�� ����#��������C�4�]�,&������1���h��������&��G�j����������,-���-���4����

����������d��&�,"����<�+j�'��&���%�8&�M�7������J�=O�a}XYK ���

��
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*4�=������������]�,&�	���4�������5����Edit Comment���,"����Comments&���j�'���'����M�7

�	,	��,4�
� $E�%���'��?����B����%�1���-4��-���-j�'�������$4�r!-D���M�7�-�����-�4������Delete������,-"����

Comments�$4����5����� ��

����������j�'����4��M�7+���������	�����$\������&�H�����4��>���0�����+�����O$	��,��������$\	���������������;�

��'��>����������M�7�j�' ���-�%��,-��b'+�-$&�������Office�������-�4��PowerPoint Options*4��-���

$4���J�=O�i~XYK ���
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�231 .��!�,<��PowerPoint Options  

�����-;�����-7&����PowerPoint Options�
-1����� Personalize your copy of Microsoft Office ����

$�&����4� User name �������,4���������>���������4��OK*4��$4�����J�=O�iWXYK ��



��

��"� �

��

���,���5��6����@A�B*��
����PowerPoint 2007�������

����	75����������
����C��	�-
@A�B*����
� �

��

��
�231 ���!0���?��������PowerPoint Options  

���,4��G�j����Q��B	�����;M�7�j�'� ���$\	�����������&�,%�@���'��>��������  

����������<�
	,	����
	�������M�7�j�'���,4��G�j��%���

�� ���	�(�
	���	��F����,4����$4��G�j��<������1/�����h���$C�  

	� ���--�4��������3�--1�������--�����--O	New Comment��--�������Review4��--�*4�--�$����

��	)5����<�����'�7�j�'  


�� ����,%����.�','�B��%������������	+������z�-j�'���h-���<������5���r�%�����$4��G�j��7�j�'�

��%��  

�� ��9��h��M�7�j�'���4�������5��������3�1���Edit Comment�	j�'�B�����M�7�-	,	�
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��$4 ��
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�������A. ���9��) B���C���!���/�=.��Package for CDD��

�������������-&����5�-���5*�1&������
	�����	���F	�����4��F�<������-��+�������������-����
	�-����-�%�1���-4����-&��

�����$4�=k�$&��,#	��,'��U&�4+���������G������,������O&����BO�&����%���������������-�����5�-�����-��,#	����

�����N����2&�
	���� ���
	�������BO�&�B	,��$����,#	���,'��U&�4����+�������8-����%�8&����������� ���-"R	�

Package for CD+�&�T%,G��*O8&���%��������,#	��,'��U&�4����
	����9�k�����$4� ���-����"R	��B	

�]�(����������������G��*�(���
	�����	���,����������&��)(����'����<��+�%���������=-	�G��-	���-������-&�,	��I'�����-%��

���������+�)(�B	���	��������,4���,8G��CD+DVD ���=-�D�=-������-%�)��,#	����
*G��SG�D��	�+�

�&��,�>���$4� ��

�&��,�������5������B	�,�����:����������PowerPoint Viewer���4�����G�j�
	����=	�G������4��>���0

�&���&����������,#	��,'��U&�4�,%������'+����������-&��,��.I�����������O$	������PowerPoint��������
	�-����-����

�,4�,( ��

���"R	�������5����,�Package for CD���$&���Office��$	)"�Publish�����$4�3�1����������\-�/�

�������������$	)"�Package for CD���	������*4�J�=O�iaXYK ��

��
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�����7&����4Package for CD�&���%�8&�����+����4��������>�,S����&�����Name the CD�������$;�

J��&�,"���������9�-�G�
	�-���,-�����-:���%�>+�������������-�4�������-�$4��G�-j���->���\-��������,-#	��
	�-��� 

Add Files��$4���*4� J�K=O��iiXYK� ���

��
�231  ��!�0���?�����<�Package for CD��

���4��������*4���Options+�����7&����4�Options����-&���%�8-&����-�� ���-�D�����Package type ���-��

��$	)"�3�1��Play all presentations automatically in the specified order���
�-���-$	)"��-4����P,-G

��+�����������,����Q��CD��,'��U&�4����+����
	������������%�>�,(���4��>���0� �&�,"����G���%�>��%�

=	�G����%�>���\�����������������D��������$4��G�j��Include these files +�$	)"���%��Linked files�

��Embedded TrueType fonts��$4�3�1������ �'��?�����&��4��,��b'���
	������,4������,����%�>

�<+���-�$4�`-	,�'���N:���*4�+�������-$�&���-%���4��������->�,S����-&��-�*4�Password to open each 

presentation�� Password to modify each presentation ��	��������J�=O�iYXYK ���
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� ���

��
�231 !��!�0���?�����<�Options 

���4�����OK�����7&����4��'���$4���*4�Options���������-7&����-4�����-����\-��Package for CD���

��	������%�8& CD ���	����������>�CD-RW��%���,��� ���4�����Copy to CD���*4��$4�� ��&���

��&�,%�@������&��������4�����=	�G��	<���,���%����,'��U&�4�������=I�&��CD���,-�>��	�����=k�$&�����

���$	)"Yes��������,	!��M��?���4�B	��'���$4���*4�� ����,�>���O$	���Q������������CD����������-����-�����-�'����

��,(CD�=	�G�&�
	������4��>���0����
	��������	 ��

��� ��������"R	�������5��Package for CD���G�����,�%����8	����+�=	�G����%�����-�������%

��	�����<CD����N:���*4�����$4��,�>���,���$4�9��:�
	������,4����� ��
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Rehearse  

You can rehearse your presentation to make sure that it fits within a certain 

time frame. While you rehearse, use the Slide Timing feature to record the 

time that you need to present each slide, and then use the recorded times to 

advance the slides automatically when you give your presentation to your 

actual audience.�

• The Rehearsal toolbar contains: 

��

1- Next (advance to next slide) 

2- Pause 

3- Slide Time 

4- Repeat 

5- Total time for presentation 
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� ���

�E������� ��
Action Button *�:���4��'����

Animation ��	�����	J�e,7�&���*(K��

Automatically �����4��>��0��

Blind �����7&��

Comments j�'�M�7��

Fly in �75?�=>������,���

Fly Out �75?���H��>�����,���

Hide 51&����,4��

Media �������

Movie T*�G��

Next ������

Play ��,4�
1���

Previous *N����

Publish ��8����

Record ^Nj���,4��

Remove r!D��

Sound �?��

Timing ��&���$����
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F���4�G��HI��
• ������������!"�9��:�,�����:�
	������%�	+�PowerPoint������-*(�9��:���O&�����-%������e,-7�&��

��������,4�T%,G�)����	��������,?�$:�  

• ��)�Custom Animation+�I1����O&����*(�������%�&�T%,G���e,7�&������<  

• ��4����%��'��*�:��+���4�����%����������<��,���?�>�=�:�P,G�
����0�����4��$�\%��	������,-S������-%

�������G,"����� �&�������������)�������5����������>���������&��'��*�:���4������'Action���,"����

Links���������Insert��$4���F	�� ��

• ������
	��������	�	�	���	���'�?�=	�G��	���,4��G�j��,�+������-�����Insert�������-�4��Sound�

��	Movie �����.\D,��+���,"���Media Clips��$4���*4� ��

• �,�����,"�������5���,(��	��>��Start Slide Show ���-�4����Custom Slide Show�

�&����5������� ���

• �����5���������4�Set Up Slide Show���,"����Slide Show��&����
	������7����'T�S$'�

��G�j��	�r!D�
	������#$%����'���[&�����,;�,;� ��

• ��"R	�Package for CD+���9�k���]�(������,#	��,'��U&�4����
	���������-&��)-(���-�'����<
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�� �>��%�;<=!�:!�?!@$�%A���A%�B CD Transition to This Slide (��E!�����'F'G���%�F 7��#F$�

������HI�(9�� 7�#>�A�J�K'�����!�?�&7!�@7�L�����>��$K'�MN�����

� �OP!�Slide Option  � �� �Q��Slide Setup��

� �R��Modify Transition� �%���Slide�Advance��

	� (���%�;<=!�# $%�?!@$�:!�@�S=!�K��E%�$�(;T��I!�>�M%�L 

� �OP!����4��Set Up Slide Show��������� �Q�����4�Slide Show���

� �R����4��Hide Slide �� �%������4�Rehearsal Timing 


�� *��+�RA%�I!�>(���%�;<=!�#U�V��?!@$�:!����'W��$�KC�%%A�H�I�A�:!�(��)��M%�L 

� �OP!��Insert > Sounds > Sound From Clip Organizer��

� �Q��Insert > Sounds > Sound From File��

� �R��Insert > Sounds > Record Sound��

� �%���Insert > Sounds > Play CD Audio Track 

�� X�:!�(LA�;=�I!��!�K��BY�=�I!�>(���%�;<=!�IA!V>!�#�M%�L��

� �OP!�Custom Slide Show ���� �Q��Set Up Slide Show��������

� �R�Hide Slide ������� �� �%���Advance Slide��

5- How can you insert a movie into a PowerPoint slide? 

a- You need a video camera and USB cable. 

b- You need to buy Microsoft Movie Maker. 

c- Click the Media button on the Office button. 

d- Select Insert >Media Clips >Click on Movie Button 

���@'H%�Z�L�!A�A!���?�[;�\ 

���# $%�%�$A�$��H@'H%�]'.���!A�(��'� "�I\ 
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�� ��4�������5�������%�*�:��'��+�������8"������O&�	�����%������9���	��%�	������F�	�  

�� ,��,%�	������	��%�	,�'��!"��	$4�`��  

�� j�'�'�7������������	O������	$4��G�j��%��� � 

�� ��,�%�B5*'������5�����	��������B�	F��9��	*4����I'�u	,��������.��$&�	$4��G�j�
��  

�� ��)�������5�����Rehearsal��&����$�����	b'����%���%��,�� ��
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� �!"����#
$���
���������	
�New Presentation%����
������&�' � 

� �(���Blank and recent� �)��Install Template���

� �*��Install Templates� �����My Template 

+� �����������������
��	����
�
����������������,-���	�
-������./�	�������
������%�
���
���,���%�
�

0�
 ��1�2
��&3����/ 

� �(���Slide Sorter� �)��Slide Show� �*�Notes Page � �����Normal 

4�� �� �!"Autofit to placeholder%���
����	�
���5��&��� 

� �(������������	
��������� �)����������������
��	
�����������������

� �*��������������������	
�������� �����������������������	
�������� 

6� ��'7
����Outline����8��
�����9
:,;���'<���= ���	����1��,���>'#��?�� :�@�
/�����.��

%����
�����	�'A���5����1��2��B
C����,���>'�
D�&��2 

� �(���Esc� �)��Enter� �*��Enter + Ctrl� �����F5 

E� /�	���%����
�������!�������������,���� '���FD�G����''H�&��2 

� �(���Theme Colors��������������� �)��Pure Color and white����

� �*��Background Style����������������� �����Effects 

I�� %�����J���
����������� �!"��������,������% �����
��?�����B
C��	����&��'" 

� �(���Shapes� �)��Symbols� �*��Text Box� �����Quick parts��

K� ��L �� ���)
M���� ��� ���� ����� 1N
5� �
� �� ��� �� ��"� 32���
�� 	��
O� 	
��� >''./�

%��&�' � 

� �(���Slide Master� �)��Handout Master�*��Note Master� �����Slide Sorter��

P� ��� �!"������Q#�����������?�������*�����L ������%���
��&�#� 

� �(���Table Style� �� �)��Borders��

�����*��Rows & Columns� �����Delete Placeholders��

R� >���	�����������?2�	#���'A��
��S'��'D�%��������
�����������%TM�����%����1����

�%�
=����5%���?��/&�������
����� 

� �(�� ����!�������� �� �)�"���!������#�$(Comment)��
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� �*����%��������&
����Action����� ������'(��)(*�������&
����+��

�U� ������
��������Q
=2��	��
O�9
'V�WX��''H/�	���PowerPoint�
������%���&��2 

� �(���Home� �)��Animation� �*��Design� �����Format��

��� %WM2���A��	�
���
%��9��V�	��!����5�
��Y�$���	�&��'" 

� �(���Animate� �� �)��Transition Sound��

� �*��Custom Animation� �����Transition Speed��

�+� ���!������%/
'A�:������*���	���Shapes���
������Insert%��)
M�������� �!"�������&�' � 

� �(���Basic Shapes����������� �)��Flowchart��

� �*��Action Buttons������� �����Callouts��

�4�� %������5����!��������
�����
�������2�Z[C�	��V�?��/Sound����Media Clips���,�������

&�#!B� 

� �(���Sound from file������������� �)��Sound from Clip Organizer��

������*��Play CD Audio Track������������ �����Record Sound���

�6� 	���%����
������ �!"���������%T�
���	���������
�����&��2 

(���From Beginning�������� �)��From Current Slide�����������

*��Custom Slide Show������ �����Start Slide Show��

�E�� %����\5��&�����[�
$�������
���	�����]'J��?
���?��/ 

� �(�����%��������&
������Rehearsal������������ �)��)���������&
������Animations��

� �*�����
��&,����������)Show Options�������������Advance Slides��

�I� %�M��	
���,���?�����	���%����
�����	�'A���5������
����
� ���&��2 

� �(���Esc������������ �)��Enter� �*��B� �����H��

�K� 
����
���������������������3�^J Transition to This Slide %��?��/��>'-'./����-�����-��

��A��	
��%T�
��������;��'/
��/���
�������2�
��
���'A��&_#
���

� �(��Slide Option  � �� �)��Slide Setup��

� �*��Modify Transition�       � �����Slide�Advance��

�P�� ������''H/�	����%����
�������!���������������������	
���&��2 

� �(���Refresh Data �����        � �)��Select Data���������� 
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� ���

� �*��Edit Data�����������             � �����Switch Row / Column���

19- Which of the following is a way to cut text? 

a- Select the text and press <Ctrl> + <X>. 

b- Select the text and press the delete button. 

c- Select the text and select Copy on the Office button. 

d- Select the text and press <Ctrl> + <V>. 

20- Which of the following is Not one of the PowerPoint’s views? 

a- Normal View 

b- Presentation View 

c- Slide Show View 

d- Slide Sorter View 

��������
�	�����������

�� ��"������)-�������.�/���0/�(�+��/�(��1�(����2�.������+3��45��6�������*���7/�����45��8 

+� 9�����/3�����:������;��5�-��������1������8 

4�� &
�����)(*���������3.'(�����+9���)���<=�����>������/9���)��	
�����1����/�?���.�)(3�������

9��/���3�/�(����7�/�8 

6� 9�����/�@�������/�.�*�!���A�"������BC�������8 

E� 5���+�)��A�"������BC����/>+9�����/�(��)��"���3��/�8 

I�� 9������/�?���.�������3.����(��������1����.(���/3��0��8 

K� "�����$+�)�������;��������(3�)�����/>+�(���D������/�*�)��"��0��8 

P� /����E�F+��+��(��)������9*/�*�)��"��0�� ����)*��/�������.�(��/���=�04 �08 

R� ��/9��������������������������G7/��H>I�.����.���� ���������*�)��"��H>I�)�����+�
�������*�6��������+'>I��;2

��E�'*����������*��I����+
��
�/��J��2�)��K�����)$&D�L�2�.�8 

�U� ���.�3�/9�����E/��3�/�?����M=�E/�*�N��8 

��� ���%��������&
�����Rehearsal��������.9���/�������3���3�����8��
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5- d)��

�����	���"������������

� �
� �� ������ ������ ���������

5- d)��
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19- a) 20- b) 
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1- Office.microsoft.com, “PowerPoint home page” 

2- Microsoft Office PowerPoint Help. 

3- Kapoun,Jim. The Use of PowerPoint in the Library Classroom: An Experiment in  

         Learning Outcomes. Library  Philosophy and Practice, Vol. 6, no. 1 (Fall 2003.) 

      Available: (www.webpages.uidaho.edu/~mbolin/lppv6n1.htm)�

             ISSN 1522-0222 
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